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EXPLORING HANDY FEATURES OF MS-EXCEL 

. 1.0 INTRODUCTION 
A spreadsheet is a two-dimensional array of cells which are used to store and process 

data. An individual cell in a spreadsheet is addressed by the corresponding row number and 

column and can be used to store one data item. The utility of spreadsheet depends upon the 

operations allowed on the data by the associated software. The computerized spreadsheets 

allow quick formulation of problems of a wide variety without use of any programming 

language. A number of spreadsheets packages are currently available, for example, Lotus, 

Microsoft Excel, and Quattro Pro. The main advantages in using an electronic spreadsheet 

are: 

• Alphanumeric data can be stored in the worksheet, 

• A huge sheet which can be easily scrolled is available for storing and analysing the 

data, 

• Data entry is very easy and various built-in features are available to speed up the jub. 

• Calculations can be performed using formulas and built-in functions. The variables are 

denoted in terms of their cell address, and 
A formula can be written for one cell and then copied to other cells, 

• Using the data stored in the worksheet, graphs can be plotted very easily. 

In the following, the main features of Microsoft Excel will be described. 

2.0 MICROSOFT EXCEL 
The Microsoft Excel (MSE) is a package for data manipulation through an electronic 

worksheet. Fig. 1 shows the opening screen of MSE with an empty worksheet. 

The MSE can open and save files in many different formats from several applications, 

including Lotus 1-2-3, Quattro Pro for MS-DOS and dBASE. To specify the type of file that 

a user wants to open or save, he chooses Open or Save As from the File menu. The 

appropriate file format is selected from the Open or Save As dialog box. 

2.1 Entering and Editing Data 
A cell can contain constant value such as numeric data, date, time, or text. A data 

value can be entered in a cell by moving to that cell through arrow keys or mouse. After 

typing the data, ENTER or an arrow key is pressed. The data values once entered do not 
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change unless they are edited. A cell can also contain a formula which is a sequence of 

values, cell 

references, names, functions of operators that produce a new value from the existing values. 

Such values, produced as the result of a formula, can change when the other data values 

appearing in the formula change. 

Fig. 1 The Opening Screen of Microsoft Excel 

The MSE was developed by Microsoft Corporation, USA. A variety of data analysis 

capabilities are available in MSE. Besides, comprehensive on-line help and tutorials are also 

available. The entire system is menu driven. The main features of this software are described 

below. For further details, the user can refer to the Users Manual for the software. A number 

of books describing the software are also available. 
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In MSE, the normal document is termed as workbook. A workbook consists of many 

sheets such as worksheets or chartsheets. The data are stored in worksheets. When the 

MSE is started, a new empty workbook is created. When a new workbook is created or 

opened, it is displayed in a window. One can move or copy sheets between workbooks. A 

worksheet is a grid of rows and columns. Each cell is the intersection of a row and a column 

and has a unique address. In MSE, the rows are numbered 1,2,3... and the columns A,B,C... 

For example, the cell at the intersection of column D and row 4 is the cell D4. The size of a 

sheet is 256 columns and 16384 rows. Fig. 2 shows a typical workbook of MSE. 

Fig. 2 A typical workbook of Microsoft Excel 

A number can be entered in a cell by moving to the desired cell and typing-in the 

number. As the text/data is typed, it appears in the active cell and the formula bar. The data 

is stored in the cell after pressing Enter or Arrow keys or clicking the Checkmark button on 

formula bar. When typing numbers, in addition to the numerals 0 to 9, the special symbols 

- ) $ % E e" can also be entered. A +ve sign before a numeric entry is ignored and 
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a number preceding with a - ve sign or in parenthesis is considered a negative number. If a 

number is too big to be displayed properly, MSE either displays a series of pound symbol 

(14:04#) or switches to scientific notation. Making the column wider solves the pound sign 

problem. The dates and times can be entered in several commonly used formats, e.g., 18-

Apr-97 or Apr 18, 1997 or 4/18/97 or 9:15 PM or 9:15:30 PM or 21:15 or 21:15:30 etc. The 

user can create his own formats also to store dates. To treat the date-like entries as text ( 

say part number of a spare part), precede such entry with an apostrophe (which is not 

displayed), or by a space. 

The number displayed in a cell is based on the cell number format and may differ 

from the number MSE stores. The general format displays the numbers as precisely as 

possible, using integer format, decimal fraction or scientific notation. However, the numbers 

are stored with 15 digit accuracy and in calculation, the stored number is used irrespective 

of how it is displayed. 

2.2 Changing Column Widths and Row Heights 
Sometimes it may be require to change the width of columns or the height of rows to 

accommodate the data. For instance, MSE often displays a series of pound signs (tt#4#14) 

when the results of a calculation won't fit the cell width. If an entry is too big to fit a cell, the 

user could switch to a smaller font or otherwise change the cell's content and format. MSE 

offers a number of ways to adjust column widths and row heights. The user can adjust a 

single row or column, or select multiple rows or columns and change them simultaneously. 

The size changes can be made by double-clicking or dragging, or the dialog boxes can be 

visited. 

When the mouse pointer is placed on or near the right edge of a column label, the 

pointer changes into a thick black bar with arrows pointing left and right. If double-clicked, 

MSE's Best Fit feature will automatically make the left column wider or narrower as 

necessary to accommodate the longest entry in that column. When multiple columns are 

selected before double-clicking, each selected column will switch to its best fit, making every 

column of different width. 

Row heights automatically increase to accommodate the tallest character in a row. In 

addition, heights can be changed using techniques similar to the ones used for column 

widths. Single or multiple rows can be changed at once. Pointing to a row label changes the 

pointer to a thick horizontal bar with up-and down-pointing arrows. Double-clicking results in 

a best fit (taller or shorter rows). 
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While the mouse tricks just described are the most convenient way to adjust column 

widths and row heights, the user can also use the AutoFit choices on the Row and Column 

submenus reached via the Format menu. If changes are made to the contents of cells are 

changed lateron (add or remove characters, for example), the user may need to use AutoFit 

again, since the column widths will not automatically readjust. Use Undo (CTRL-Z) to restore 

column widths and row heights. Incidentally, AutoFits are computed using screen fonts. As 

a result, it may be occasionally needed to readjust columns and rows manually before 

printing. To see if this is necessary, use MSE's Print Preview feature. 

To manually make column width and row height decisions, drag with the pointers 

rather than double-clicking. When the mouse pointer is placed on or near the right edge of 

a row label, the pointer changes into a thick black bar with arrows pointing left and right. 

Dragging displays a light line showing the column width that will result when the mouse 

button is released. If multiple columns are selected, dragging one will make all of them of the 

same width. 

2.3 Copying and Filling Cells 

The contents of a cell can be copied into other cells by Edit menu or by dragging the 

fill handle. The cells to be copied are selected, and copied to the clipboard Edit ; Copy or 

Ctrl+C. Notice that the boundary of the selected cells changes to a flashing-dash boundary. 

Now move to the desired location and press or Edit:Paste to complete the copy operation. 

The content of a cell can also be copied to other cells using the Fill command from the Edit 

menu or the fill handle. For example, let us select a cell containing a number, say 10. To fill 

this number to the other cells, point to the fill handle at the lower-right corner of the cell. The 

pointer appearance changes to a + sign. Now drag the fill handle in the direction of fill, 

releasing the button fills the data into the range. 

When the fill handle is dragged in a range of cells containing the values that MSE 

recognizes as a series of sequential numbers, the series is incremented in the selected 

range. For example, let the contents of the selection cells be 10 and 20. The fill handle is 

now dragged forward to other cells. When the mouse button is released, the extended series 

will be 30, 40, 50.... This procedure is explained in Fig. 3. 

A frequently used special series of data can also be created and filled using AutoFill. 

To use AutoFill, highlight the cell(s) of interest and then drag the fill handle at the bottom 

corner of the active cell outline. The pointer tums into a plus sign and is dragged to the last 

cell up to spreadsheet is filled. Releasing the mouse button fills the cells. MSE comes with 
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several built-in AutoFill lists. Additional lists can be created by choosing ToolstOptions from 
the menu bar. Next click Custom Lists tab and then New List in the Custom Lists area. Now 

type the list in the List Entries area. Click OK when finished. 

Fig. 3 Filling the data in a sheet 

2.4 Navigating in the Worksheet 
The arrow keys can be used to move up, down, left and right in a worksheet. The 

Page-up or Page-down keys move up/down by one window. Several hot keys are available 
for easy movement in a sheet. Home key moves to the beginning of the row, Ctrl+Home to 

the beginning of the sheet, and Ctrl+End to the last cell containing data in the sheet. One can 
also move to the desired location by using the vertical and horizontal scroll bars. The Edit: 
Go To command is used to move to a specific location on a worksheet. The Find command 

from the Edit menu can be used to find specific characters on the worksheet. The scrolling 
button on the bottom of the screen are used to switch between different sheets in a 
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workbook. 

In many instances, it is necessary to select a group of cells which are always 

rectangular blocks of cells. A range of cells can be selected by dragging the cursor diagonally 

from the first cell to the last cell. To select nonadjacent cells, the Ctrl key is held down and 

the mouse is clicked through additional cells. An entire row is selected by clicking the row 

heading, an entire column by clicking the column heading, and all the cells on the sheet are 

selected by clicking the Select All button. 

2.5 Entering Text 
To enter text, select a cell and type the text. Pressing the Enter key, or clicking the 

Checkmark or and Arrow key concludes the text entry. Pressing Escape key before 

completing text entry cancels the entry. A cell can hold up to 255 characters. The appearance 

of text can be changed (change font, bold etc.) within a cell or each characters can be 

handled individually. The user can create text entries that include numbers & text. First, the 

user applies the text format to the blank cells. Choose the Cell commend from the Format 

menu, select the number tab, and then select the text category and the @ format code. 

Another way to enter a number as text is to precede the entry with an apostrophe. 

Instead of letting long strings of text overflow into adjacent cells, the text can be 

displayed on multiple lines within a cell. This is called text wrapping. Before wrapping text, 

adjust the column to the desired width. Choose the cells command from the format menu, 

select the Alignment tab and then select the Wrap Text check box. To enter text in formulas, 

enclose the characters in double quotation marks ("). One can also create Text Boxes and 

place them anywhere on the worksheet. The text in these boxes can be rotated also. A text 

box can be created by clicking the Text Box button. The spell checker can check the spellings 

in the entire worksheet or in the selected portion of the sheet. 

2.6 Worksheet Editing 
The user can edit a cell on a worksheet by typing a new entry over an existing one 

or by editing the information within the cell. To edit within a cell, double click the cell. When 

editing a cell containing a formula, the formula is displayed in the formula bar and the value 

is hidden. To edit cell contents, choose commands from 'edit' menu. The location of cell on 

a worksheet can be also changed by copying or moving cell to a different part of the same 

worksheet, to another worksheet within a workbook or to another application. Fig. 4 explains 

the steps of copying and moving cells. Spelling command of the' Tools' menu is used to 

Training Course on 
Basic Computer Skills X-7 NIFf Roorkee 



2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 

A 
2 
4 
6 

10 
12 
14 
16 

10 
20 
30 
40 
50 
60 
70 
80 

Exploring Handy Features of MSExcel 

correct the spelling of worksheets and charts. If the user frequently uses some specialized 

terms he can create a custom dictionary. To create a custom dictionary, choose the spelling 

command from the 'tools' menu, type a name for the new dictionary in the Add words to box, 

and then choose the 'Add' button. 
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Fig. 4 Copying and moving cells 

2.7 Formulas for Data Analysis 

A worksheet cell can also store formulas. The forrnulas'are used to analyze data in 

a worksheet. A formula can be typed in an active cell. The formulas available in MSE can 

perform operations such as addition, multiplication, and comparison on worksheet values. A 

formula begins with an equal sign(=) and can be thought of as one side of an equation whose 

result will appear in the cell. For example, a cell, say 81, may contain a formula =A1*5. If the 

content of cell Al is 10, the value in cell 81 will be 50. A noteworthy point is that lithe 

content of Al is changed to 50, the content of B1 will automatically change to 250. Normally 

the resulting value of the formula is displayed in the worksheet. However, by selecting the 
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View tab in the Tools:Options dialog box and putting a Checkmark in the Formula box, the 

formulas can be displayed instead of results. When a cell containing a formula is selected, 

the formula is displayed in the formula bar. The formula contained in a cell can be copied to 

a new cell. If MSE can't calculate the formula for a cell properly, an error value is displayed. 

In Excel, there are four general categories of operators: arithmetic, logical, text and 

reference. The arithmetic operators are : addition +, multiplication *, subtraction -, division /, 

percentage ck, and exponentiation A. The logical operators are used with logical IF to come 

to a conclusion based on the relative values of the operands. These are : equal =, greater 

than », greater than or equal to >>=, less than <<, less than or equal to <<=, and not equal 

to 0. For example, suppose we want to compute and display the difference of the contents 

of cells 83 and 82 if the result is positive and error message otherwise. The formula in the 

desired cell would be : =(IF((B3<<62), "Negative answer', I33-B2). This formula would 

compare B3 and 82. If B3 is less than 82, the text "Negative answer' will be displayed else 

the difference of these two will appear. 

The only text operator in MSE is & It concatenates two text strings. As an example, 

if the contents of Al are "Bharat" and of A2 "Mate, the result of the formula =A1&A2 would 

be ''BharatMata". 

The data located in different areas can be referenced in a formula by using either 

absolute, relative or mixed reference. An absolute reference is given by putting $ sign before 

the row and column address (e.g., $A$6) while A6 is a relative reference and $A6 is a mixed 

reference. When a cell containing a formula is copied or moved, the MSE automatically 

adjusts the relative references and the relative parts of mixed references. For example, if cell 

B8 contains the formula =B2+133 which is copied to C8, the formula becomes =C2+C3. 

Likewise, if the formula =C$4+$B$1+$65, stored in cell C5 is copied to cell F8, the formula 

becomes =F$4+$B$1+$138. The data stored in other sheets can also be referenced in a 

formula. 

A function is a special pre-written formula that takes value(s), performs an action and 

returns values. Functions can be used alone or as building blocks in larger formulas and 

simplify and shorten formulas. For example, the formula =A1+A2+A3+A4+A5 can also be 

written as =SUM(A1:A5). A formula can also be build using a tool known as Function Wizard 

which can be invoked by clicking the Function Wizard button. See Fig. 5 for the steps. 

By default, MSE recalculates each time the user edits any number in the worksheet 
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and recalculates before saving. These options can be changed in the Calculation dialog box, 

reached via Tools ; Options. 

Fig. 5 Building a formula using Function Wizard 

2.8 Creating a Chart 
A chart is a graphic representation of worksheet data. To create a chart from 

worksheet data, it is necessary to choose the chart type that presents that particular data 

most clearly and effectively. MSE offers 14 different chart types. Values from worksheet cells, 
or data points are displayed as bars, lines, columns, pie slices, or other shapes in the chart. 
Data points are grouped in data series, which are distinguished by different colours or 

patterns. The Chart Wizard is a series of dialog boxes that simplifies the creation of a chart. 

It guides the process step by step; the user verifies the data selection, selects a chart type, 

and decides whether to add items such as titles and a legend. A sample of the chart being 

created is displayed so that the user can make changes before finishing work in the 

ChartWizard. 

The user can choose a chart type for the entire chart or can assign a chart type to 

one or more data series. Each chart type has at least one subtype, which can be chosen to 

show the data somewhat differently. User can use subtypes and chart type in combinations 
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to create a variety of looks. After a chart has been created, it can be moved, sized and the . 

look of many chart items changed by applying an autoformat to the chart instead of selecting 

and formatting individual items. Autoformat changes the entire look of the chart but does not 

affect the data. To change the chart type first activate the 'chart'. Then choose the 'chart 

type' command from the 'Format' menu and select the chart type. The user can quickly 

combine chart types by choosing a combination autoformat instead of changing the chart type 

for individual series. 'Autoformat' command saves time and give the charts a consistent look. 

The user can use built-in 'autoformats' or can create own custom autoformats. 

2.8.1 Creating a Chart Using the Wizard  
Using the chart wizard, a chart can be created by following these steps: 

Start by creating a worksheet containing the data to be plotted. 

Select the data to be included in the chart (drag to highlight the relevant cells). Don't 

include empty rows or columns. 
Click on the Chart Wizard button, located in the Toolbar. The pointer turns into cross 

hairs with a little chart attached. 
Drag the pointer to define the size and shape of the new chart. To create a square, 

hold down SHIFT while dragging. 
When the mouse button is released, the user will set the first of five Chart Wizard 

Step dialog boxes. This box shows the range of the data to be charted and gives a 

chance to alter the selected range. If the range is OK, click the Next> button at this 

point, to move to Step 2 of 5. 
The Chart Wizard can create many chart types and many formats for each of those 

types. The Step 2 window illustrates all the chart types. It's usually obvious from the 

chart samples which ones are best for various purposes. When a chart type is 

decided, click its sample to highlight it. Here, the Line chart has been selected. Now 

click the Next> button to continue. 
Once a chart type is chosen, Chart Wizard presents the Step 3 dialog box showing 

various formatting options, which are different for each chart type. Formats can be 

changed later. The user may start with the choice the Wizard suggests, and 

experiment after seeing those results. Click the Next> button to continue. 

In Step 4, the beginnings of the chart design will be displyed in a Sample Chart box. 

If it is OK, forge ahead. Don't worry about the actual shape of the chart at this point, 

and don't be alarmed if the labels are temporarily truncated (shortened) or replaced 

with words like "Series 1" and "Series 2". 
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Watch the preview. Think about the general presentation of the data at this 

point. Does the chart help in understanding the data ? Does the user have the 

appropriate data on the right axis ? Is the chart type OK? If not, the user can use the 

<Back button to return to the earlier steps and pick a different chart type or format. 

Sometimes the option buttons in Step 4 can improve the chart. Click Next> to move 

to the last step. 

9. Step 5 gives a chance to add chart titles for the chart itself, and for each axis. The 

user will see the titles appear in the Sample Chart area as he types. The "Add a 

Legend?" option turns legends on and off. 

When Finish is clicked, MSE will create a chart worksheet. 
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Fig. 6 A Chart Embedded in a Worksheet 
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2.8.2 Creating Charts on Separate Worksheets  
Excel charts can either be an integral part of the current worksheet, or they can be 

separate chart worksheets (see Fig. 6) in the workbook that are linked to selected worksheet 

data. Chart Wizard usually creates chart objects on the current worksheet. The whole process 

is simple, clean, and automatic. But if desired, charts can be placed on their own worksheets 

within a workbook. To create a new chart on a separate worksheet. 

Select the data to be charted. 
Choose New (Chart) option from the Insert Chart 1 As New Sheet command. 

The Chart Wizard will be displayed. Use it as previously described. 

The Wizard will create a new sheet with a tab containing the word "Chart" and a 

sequential number. 
Each new chart created this way gets its own worksheet in the current workbook, and 

thus its own tab. Rename tabs by double-clicking on the tab. 

2.8.3 Resizinq and Moving Charts  

If it is required to change the size or shape of a finished chart, it is easily done by 

dragging the little handles that surround a selected chart. Besides making room for previously 

cramped labels, resizing charts changes their size and shape, and thus the appearance of 

the chart markers and other chart elements. Resizing is particularly useful if the data labels 

are invisible or all scrunched up. Resizing a perfectly nice chart can make it unreadable. 

2.8.4 Adding Chart Notes and Arrows  
Often it's nice to be able to draw attention to, or explain, certain items on the chart. 

The boxed note is an example of this. To create boxed text : 

Click on the Text Box button. It is in MSE's Drawing Toolbar. 

Drag to create the outline of a text box in the approximate desired size and shape. 

Type and edit the note using text-editing techniques. 

2.8.5 Restyling and Resizinq Text Boxes 

To resize the box or move it, point and click on any edge. The outline will thicken and 

eight size handles will be displayed. Drag and resize this outline. To embellish text, select 

it and use the Standard Toolbar or text-related menu commands. 

To change the outline or fill pattern used for the box, or to add a drop-shadow effect, 

double-click on edge of the text box. The user will have the Format Object dialog box to do 

required changes. Choose the desired tab and options within the tab. 
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2.8.6 Drawing and Formatting Arrows 

To draw an arrow : 

Click the Standard Toolbar's Drawing button to display the Chart Toolbar. 

Click the Drawing Toolbar's Arrow button. 

When the pointer turns into cross hairs, point where the arrow is to start, and drag to 

the ending point. 
When the mouse button is released, an arrow will appear. Either end of selected 

arrows can be dragged to reposition them and/or change the length of the line. 

Double-click exactly on an arrow to bring up the Format Object dialog box, which 

helps to define arrow styles, line thicknesses, colors, and much more. This changes 

only the arrow that has been double-clicked upon. To reformat other arrows 

immediately afterward, select them (by SHIFT + clicking), and use the Repeat Format 

Object command on MSE's Edit menu. 

2.8.7 Editing Charts  
It's possible to change chart types and formats, embellish text, choose patterns or 

colors, add gridlines, insert notes with arrows, and much more. The right mouse button 

reveals a number of chart-related choices if the user points and click on a chart. This is often 

the quickest way to edit charts. Once a chart has ben created, it's type can be quickly 

changed by clicking on the chart type list on the Chart Toolbar. This provides a palette of 

chart choices. 

There are several ways to change the data series ranges. One is to select a chart, 

then click on the Chart Wizard button. The user will see Step 1 of a two-step procedure, 

which will help to specify a new data range by typing it or dragging with the mouse. The 

second step helps to, change the appearance of the chart. To select a data series, click on 

any marker in the series. The user wiil see a description of the data series in the Formula 

bar, where he can edit the series definition. To select a single data marker, hold down CTRL 

while pointing. 

2.8.8 Selecting and Editing Chart Components  
Specific parts of a chart, like text, gridlines, the shading used for markers, and so on, 

can be edited by either single- or double-clicking on them. For instance, to change the 

appearance of a chart title, double-click on it to bring up the Format Object dialog box. To 

edit the content of the title object, click once to select the object, and then select the text by 

dragging or waiting a moment before clicking or double-clicking on the text. 
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To select a gridline, click exactly on a gridline. Clicking on any axis selects it. To 

select just the plot area (the columns without their category names, for instance), click in any 

part of the plot area not occupied by other things like gridlines or markers. To select the 

entire chart, click anywhere outside of the plot area, but not on other items like titles or 

legends. 

2.9 General Formatting Techniques 
Frequently, the user can double-click on chart elements to quickly bring up relevant 

formatting options. If the user double-click on a data marker, for instance, a Patterns dialog 

box will appear that will help to select a new color or pattern for the marker. Double-clicking 

on a legend takes to a dialog box where the appearance of the legends can be rearranged, 

and so on. The other general editing technique is to select something, and then use the 

appropriate menu commands and Toolbar buttons. 

The user can create and embed chart as an object on a worksheet when he wants 

to display a chart along with its associated data. An embedded chart is shown in Fig. 6. 

Alternately, it can be created as a separate sheet in a workbook. In both cases, the chart 

data is automatically linked to the worksheet and when the data on the worksheet is changed, 

the chart is automatically updated. 

2.10 Analysis of Data 

MSE contained a set of tools, named 'Analysis ToolPak' for data analysis. These tools 

include statistical analyses and engineering analyses. Some of the tools available in this 

'ToolPak' are Anova, Covariance, correlation, F-test, histogram, moving average, random 

number generation, regression, t-test, and Fourier analysis. 

2.11 Printing 

It is necessary to select and install a printer to print from MSE. Choose the 'Print' 

command from the 'File' menu. The print dialog box opens and the print range and number 

of copies can be chosen. Alternately Print button is clicked by mouse to print immediately 

from the workbook window. The matter to be printed can also be previewed before it is sent 

for printing. The matter is displayed on the screen exactly as it will be printed. This facility 

can be effectively used to format the matter as desired before printing and this usually saves 

time and avoids wasteful printing. 

2.12 Creating Graphic Object on Worksheets 
Various type of graphic objects can be drawn using the data stored on worksheets. 
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The graphic objects are not actually part of the worksheet. They are inserted on a transparent 

layer laid over the worksheet and can be moved, sized and formatted independently of the 

data or chart underneath. The graphic object can also be drawn by using buttons on the 

'Drawing Toolbar'. Click the 'Drawing button' by mouse to display the 'Drawing Toolbar'. To 

draw a simple shape, click one of the buttons on the Drawing Toolbar and drag from one 

corner of the area where the shape is to appear to the diagonally opposite corner. Double 

click the button to draw more then one shape in succession. To stop drawing shapes, click 

the button again. To delete a graphic object click to select it and then press the DEL Key. To 

change the size or position of an object, to change the font of text or to copy or delete an 

object, it is necessary to first select the object and then the requisite change can be carried 

out. 

2.13 Help and Demos 
All the commands and features of the MSE have been documented in the Microsoft 

Excel User's Guide. Besides, an extensive on-line documentation is also available. This 

contains detailed step-by-step instructions and reference information for all tasks and features 

including commands, Toolbar buttons, functions, and the Visual Basic language. The on-line 

help can be accessed using the Help menu. A number of examples and demos contain short 

interactive lessons that focus on a single task. These have been also designed to work as 

tutorials sessions. Also included with the MSE package are some sample files which can also 

be included in the workbook of a user. 

2.14 Organizing and Managing Data in a List 
One way to store data on a worksheet is in a list. A list is a labelled series of rows 

that contains similar data. MSE has a number of automatic features that make it easy to 

manage and analyze data in a list. To take full advantage of these features enter rows and 

columns in a list according to the following guide lines. 

Avoid having more than one list on a worksheet, because some list management 

features such on filtering are used on only one list at a time on a worksheet. 

Leave at least one blank column and one blank row between the list and other data on 

the worksheet. 
For the best results, avoid storing other critical data to the left or right of the list 

because it can be hidden when user filters the list. 

A list can be as large as an entire worksheet; 16,384 rows by 256 columns. 

Create column labels in the first row of the list. MSE uses these labels to create reports 

and organize data. 
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6, Use a font, data type alignment, format pattern, border or capitalization style for column 

labels that is different from the format assign to the data in the list. 

Use Cell borders to insert lines below the labels to separate the labels from the data. 

Do not use blank rows or dashed lines. 

Column labels, like other cells can contain a maximum of 255 characters. 

Design list so that all the rows have similar items in the same column. 

Do not insert extra spaces at the beginning of a cell; extra spaces affect sorting & 

searching. 

Use the same format on all the cells in a column. 

If the worksheet data is stored as a list, MSE makes it easy to organize the list, edit it 

and create reports from it. 

2.15 Sorting & Filtering Data in a List 

MSE makes it easy to organize, find and create reports from data stored in a list. 

Sorting is an easy way to organize data in a list alphabetically, numerically or chronologically. 

Similarly, filtering is a quick and easy way to find and work with a subset of data in a list. 

When filtering a list, MSE displays only those rows that contain a certain value, or that meet 

a set of search conditions called criteria. To sort entire list, just select a single cell in the list 

and choose the sort command from the Data menu. MSE automatically selects the whole list. 

If the list has column labels in the first row, MSE excludes them from the sort and uses them 

to help choose the sort by column. Autofilter is used to display a subset of the list. 

2.16 Using Solver to Analyze Multiple Variable Problems 

The MSE 'solver' is a powerful optimization and resource allocation tool. It can help to 

determine the best uses of scarce resources so that desired goals such as profit can be 

maximized, or undesired goals such as cost can be minimized. Use solver to find the 

optimum value for a particular cell by adjusting the values of several cells. To use MSE solver 

with worksheet model, it is necessary to define a problem that needs to be solved by 

identifying a target cell, the changing cells, and the constraints that is used in the analysis. 

After defining the problem, the solution process is started. Solver finds values that satisfy the 

constraints and produces the desired value for the target call. Solver then displays the 

resulting values on worksheet. 

2.17 Statistical Analysis of Data 
MSE provides a set of special analysis tools called the analysis 'ToolPak'. These tools 

save steps in developing complex analysis scenarios. Before using an analysis tool, the data 
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must be entered and organized into columns or rows in worksheet. When the user uses an 

analysis tool to analyze data in an input range, MSE creates an output table of the results. 

The contents of the output table depend on the analysis tools which are being used. If the 

labels are included in the input range, MSE uses them to label data in output table. If the 

labels are not included in the input range, MSE automatically generates data labels for the 

result in the output table. The user can save the output table on the same sheet on the input 

range, on a separate sheet in the same workbook, or in a new workbook. If he attempts to 

save output table in a location where data already exists, MSE gives the opportunity to 

specify a new location. To use an 'Analysis tool', choose 'data analysis' from the 'tool' menu. 

In the 'Analysis tool box', select the name of the tool which is desired then specify the input 

and output ranges and any other options. 

2.18 Protecting Workbooks, Sheets and Their Contents 
Once the user creates a workbook, he can restrict the way others can access the 

workbook or its contents. MSE gives several options for restricting access and changes at 

the workbook label, at the sheet level and even at the cell or graphic object level. The user 

can: 

Prevent other users from opening a workbook or accessing its contents. 

Enable other users to open a workbook and enter changes to its contents but prevent 

them from replacing the original copy. 
Enable user to open a workbook, but not change its contents or the way it's organized 

and displayed. 
Prevent other user from entering changes to some or all of the items on a sheet. 

Hide a workbook so other users can open or access it but not see it. 

Hide selected sheets in an open workbook. 

Hide some or all items on a sheet so other user can not see them or accidentally 

change them. 
Prevent worksheet formulas from appearing in the formula bar. 

Using passwords user can mix different levels of protection for the same workbook so 

that different groups of people have different levels of access. 

2.19 Linking and Embedding 
With the 'linking and embedding' features available in MSE, the user can include 

information, or objects, created in other application. Embedding means inserting information, 

such as a chart, a graphic, or data from a word processor document into a MSE workbook. 
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Embedded objects become part of the workbook itself. Linking means inserting into a 

workbook information that retains a connection to the source document. The linked data is 

updated when the data in the source document changes. The linked data is stored in the 

source file, the workbook stores only the location of the source but displays a representation 

of the linked data. 

2.20 Importing and Exporting Documents 

With the 'open' command on the Tile' menu, the user can open documents created by 

many other applications, including Lotus 1-2-3, Borland Quattropro, and dBASE. He can also 

save documents using the 'save as' command on the file menu in file formats readable by 

many other applications. The list of supported file formats appears in the open dialog box 

under list files of type, and in the 'save as' dialog box under 'save file as' type. 

If the file type can not save multiple sheets, a message appears to inform that only the 

active sheet will be saved. The user can also open and save text files. When he open a text 

file, the Text Wizard is activated so the user can specify how the text is to be distributed 

across columns. 

2.21 Producing a Slide Show 

User can create a 'slide show' with MSE to present data, charts and graphics created 

in MSE or imported from other application. 'Slide shows' are created on a special template 

included with MSE. The user can include a variety of graphics in a 'slide show' and apply a 

number of video and audio transition effects between slides. 'Slide shows' can be saved in 

a workbook and can be viewed on other computers. Note that the slide shows can be run 

only on a computer screen or on another display device attached to the computer but they 

can not printed. 

To create and display 'slide shows', the 'slide show add in' must be installed. The help 

command gives complete information about slide shows and how they work. 

3.0 HARDWARE & SOFTWARE REQUIREMENTS 

The following hardware and software are required to use Microsoft Excel for Windows. 

Any IBM-compatible machine with 80286 processor or higher, 

A 3.5 inch or 5.25 inch floppy disk drive, 
.17 A hard disk with sufficient free space, 

.12 A graphic display compatible with Microsoft Windows Ver 3.1 or later, such as EGA or 
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VGA, 

a At least 4 MB of CPU memory, 

a MS-DOS Ver 3.1 or later, and Microsoft Windows Ver 3.1 or later in standard or 

enhanced mode, 
A compatible printer, if hardcopy output is needed, and 

J A compatible mouse (recommended). 
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